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Chapter 1

Introduction

SharpEye is a music OCR program. It converts scanned images of printed music into MIDI, NIFF or
MusicXML files. (NIFF and MusicXML are file formats for music notation.) This is a difficult task for
a computer program to perform, and inevitably there will be some errors when the music is complex or
crowded, or the input image is of poor quality. SharpEye has a built in music notation editor which has
been specially designed for checking and correcting the output before saving it as a music file.

1.1 System requirements

You need a computer with W95/W98/Me/NT4/W2000/XP. If you have an old computer, memory may be
an issue. SharpEye uses about 10Mb to 30Mb RAM to process an image, depending on the size of the score
and the complexity of the music, and this amount msut be added to what your OS uses.

You will need a scanner to scan the printed music in.

It is not essential, but you will almost certainly want a music notation editor or a MIDI editor/sequencer (if
you don’t already have one) so that you can play around with the output from SharpEye. Windows Media
Player (supplied with Windows) can play MIDI files saved from SharpEye, but the music will all be played
on a synthesised ‘piano’.

1.2 Installation

SharpEye is supplied as a single self-extracting file, usually with a name like “installsharpeye2.exe”. Double-
clicking on this will start the installation. By default, this will put the program files in the folder “Program
Files\visiv-co-uk\SharpEye2” and add a few icons to the start menu.

To uninstall SharpEye, open the Control Panel and double click on Add or Remove Programs. Select SharpEye
Music Reader 2 from the list and click on the Add/Remove button.

1.3 Brief guide

If you don’t like reading manuals, and prefer to learn by trial and error, here is a brief guide to get you
started.

Scanning

SharpEye 2 allows you to scan via the TWAIN interface. You can either use this or use another program to
do the scan, save it as a TIFF file or bitmap (.BMP) file, and then load it into SharpEye.



In any case it should be a black and white scan. Scan at 300dpi for most music. A higher resolution may be
better if the music is printed small. Try to make the scan as straight as possible.

Click on the blue arrow to start the conversion.

Music Editor
The right button is devoted to inserting new symbols.

You'll often have to insert a symbol which is not quite what you want and then select and modify it. The
tools for modifying a symbol will not appear until you select it.

The black rectangles at the start of the score are for joining staves. You should normally join staves that
belong to one instrument (usually a keyboard instrument).

Warnings about bars (measures) that SharpEye doesn’t understand are shown at the end of each measure,
and individual notes that are not understood are shown in grey.

1.4 Upgrading from version 1

If you are familiar with using SharpEye version 1, you will find most of the facilities that you are used to
work as before. Here are some things that you might miss.

Triplets and other tuplets

One thing which may cause confusion is editing of triplets and other tuplets. In version 1, it was only possible
to use triplets, and these were edited in a simple but limited way. Now the editing of triplets and other
tuplets is a bit more complicated, but a lot more flexible. In order to apply a tuplet you have to select all
the notes and rests you want to affect, not just the middle one of a triplet. See section 3.7 for more details.

New features that are easily missed

e You can hold down the Shift key and drag out a box in order to select notes and rests in the music
editor.

e The Home and End keys take you to the previous or next system.
e The Up and Down keys can be used to move a selected notehead up or down one step at a time.

e Ctrl-F4 closes the image window. Ctrl-Tab will move the keyboard focus from the image window to the
main window.

e The Save and open temp file options for MIDI and NIFF are a bit less accessible than they were. You
may find the keyboard shortcuts Alt-F-D-F and Alt-F-F-F useful.

e There is no “Progress” window during conversion, but the status bar shows the percentage complete.



Chapter 2

Overall Process

2.1 Image And Music Windows

There are two important windows in SharpEye, one that displays the input image and one which displays
the music output. The music output window is SharpEye’s main window. It contains the main menu and
toolbar, and closing it will quit SharpEye.

Here is the music output window:
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The Image window displays the scanned image. You can drag TIFF or BMP files in here. You can move and
re-size it as you wish, and change the scale at which it is displayed. You can also create a zone to process
part of the image. As you edit in the music output window, a small red cross will show the corresponding
position in the image window.
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If the image window has the keyboard focus it can be closed using Ctrl-F4, and Ctrl-Tab will make SharpEye’s
main window have the keyboard focus instead.

You can change the window positions that SharpEye uses when it starts. Arrange the windows the way you
want, then click on Save window positions in the Options menu.

2.2 Scanning

SharpEye 2 allows you to scan via the TWAIN interface. This is available under the File menu, where you
will see options Acquire... and Select Twain source.... There is also a toolbar button for the Acquire option.

The Select Twain source... option allows you to choose which TWAIN device to receive images from, if you
have more than one. The Acquire option will start up the usual interface to your scanner (assuming it is
TWAIN compatible). You should set the scanner options appropriately (see below) before scanning. You
can also use another program to do the scanning, and save the image as a BMP or TIFF file. These files
can then be loaded into SharpEye, either by dragging to the input image window, or via File - Open Image
or a toolbar button.

Note that it is generally best to save the image after scanning, and before converting it into music, since
SharpEye can then keep a reference to the saved image file, and load it as required when you are editing the
music. (This will become clearer once you start using the music editor, especially with multi-page scores.)
You will get warning if you have not saved the image, but if you find this irritating you can turn it off: see
section 2.13.

General

Make the scan as straight as possible. SharpEye automatically copes with small amounts of skew, but
accuracy is highest when the scan is straight. Be sure that the printed music is flat on the scanning surface.
If the paper is not flat, it’s likely that the image will be smudged or distorted, and this will confuse SharpEye.

Scanner settings - colours

You should set the colours to black and white. Different scanner drivers use different terms for a black
and white image. It may be described as “Monochrome” or “Line art” or “Bi-level” or “One bit per pixel



(1bpp)”, or there may be an “OCR” setting which is suitable. Note that “black and white”, which just
uses those two colours, is different from “grey scale” which uses a range of 256 greys. From version 2.50,
SharpEye will convert grey scale scans and files into the black and white format it needs, but this is not
ideal. Grey scale files uses more memory, disc space and time. If you use grey scale images SharpEye will
decide which greys become black and which become white automatically. If you use black and white scans,
the decision will be made by the brightness setting in your scanner interface, so you can set it manually.
Black and white scans therefore give you more control, while grey scale may be more convenient.

Scanner settings - resolution

You should set the resolution to 300dpi for most printed music. A higher resolution (eg 400dpi) may be
useful if the music is printed small or a lower resolution (eg 200dpi) if it is large. As a check to see if you've
got things right, an uncompressed black and white scan of an A4 page at 300dpi will be about 1Mb in size,
and an uncompressed grey scale scan of an A4 page at 300dpi will be about 8Mb in size. Another check:
when you have loaded the file into SharpEye, and displayed it at 100%, the distance between the staff lines
should be very roughly 20 pixels. The standard mouse pointer is 16 pixels high.

SharpEye will attempt to read music when this spacing is as low as about 10, or as high as 40 or so, but
accuracy tends to suffer when the scale is too small and speed suffers when it is too large. People quite often
think that they will get better accuracy by increasing the resolution. It is very rarely useful to increase it
beyond the point where staff lines are 20 pixels apart. If thin lines are broken in the scan, it is better to
obtain a darker scan, not a bigger one.

Scanner settings - brightness

The default brightness level is usually fine. One thing to watch is that with high quality printing, the staff
lines may be very thin (less than 1/300 inch) and may become broken when scanned. In this case reducing
the brightness may improve things a lot. With poorer quality printing the lines are usually thicker, or already
broken, and the default brightness level is usually best.

Scanner settings - miscellaneous

Some scanners have settings such as ‘photo’, ‘halftone’ or ‘dithered’. These attempt to represent grey levels
with patterns of black dots and are not helpful for OCR (music or text), so turn these settings off. Options
such as ‘text’ or ‘line-art’ are probably a good thing. See the section on image quality in the on-screen help
to get an idea of what kind of scans SharpEye can cope with.

2.3 Saving, Loading and Editing an Image

You can save an image from the File menu in either Windows bitmap (.BMP) or TIFF format. In the
case of TIFF, the image will be compressed using the “CCITT4” compression method, which gives excellent
compression.

To load an image into SharpEye, you can drag the file from Windows Explorer into the input image window.
You can also load images via an Open File dialog. Choose File - Open Image... from the main menu, or click
on the appropriate toolbar button, then double click on the file you want to load. In either case it will be
displayed in the input image window.

SharpEye can load most black and white BMP and TIFF images. It can also load most grey scale BMP and
TIFF files, but there is no advantage in using such images - they just take up more disc space and SharpEye
converts them to black and white as it loads them. It can load most compressed TIFF images.

You can zoom the view of the image to different sizes. This doesn’t change the image, just the way it looks
on screen. Either use View - Zoom Image or the two zoom buttons.

You can invert the image if necessary (swap black and white) from the Image menu.

You can also rotate the image by multiples of 90 degrees from the Image menu.



2.4 Reading the image

To convert the image, choose Read - Read from the main menu, or click on the button with the blue arrow.

This will start another program (the “music OCR engine”) which does the conversion. While this is taking
place, the status bar shows the percentage complete.

The conversion can take some time, depending on the size of the image and the complexity of the music -
and the speed of your computer of course. Once the engine has finished, the result will be loaded into the
music editor for you to check and edit.

You can stop the reading process once it has started by choosing Read - Stop.

If the recognition is poor, please see section 2.2 above, and “Image quality” in the on-screen help.

Zones

If you want to process only part of the image you can create a zone around the area. You can use the mouse
to drag out a rectangle in the image window. This can then be adjusted using the eight handles around its
border, or moved as a whole by picking it up in the middle. You can delete it using the Delete key or from
the Edit Image menu.

Music recognition options

You can control the recognition of some musical symbols under Options - Music recognition options... There
are four check boxes which turn on or off the recognition of various objects. The first, Old style symbols,
determines whether the following are recognised: old style clefs, old style flags (straight flags), old style
whole notes (with the hole slanted like // instead of the normal \\) and old style rests where the quarter
rest (crotchet rest) looks like a reversed eighth rest (quaver rest).

The second check box determines whether an unusual style of open note head (which is labelled ‘symmetric’)
is recognised. You may find SharpEye recognises such heads even without this turned on, but it may improve
accuracy on some Scores.

The third turns on the recognition of thin beams. Some music has beams which are just a thin line, sometimes
as thin as a stave line. Also, beamed grace notes may require this option turned on.

The other buttons determine how small note heads are dealt with. SharpEye can either treat them as grace
notes, or as normal notes (but not both in the same score). The ‘normal notes’ option can be useful for cue
notes: SharpEye does not currently deal with cue notes as such, but this option may enable you to get the
notes into another program. Grace notes do not affect the MIDI files that SharpEye generates, so it is only
useful to recognise grace notes if you are using NIFF or MusicXML.

In general, it is best to leave these options off unless you need them, since they can lead to recognition errors.

Text recognition options

You can set various options to control the recognition of text in the image using the dialog under Options
- Text recognition options.... SharpEye can recognise three kinds of text: lyrics, guitar chords like “Am”,
“Dt7”, and musical directions such as “Andante” or “cresc”. In this dialog box, ‘other text’ means chords,
directions, and any other non-lyric text which appears to belong to a stave. If you are using MIDI you
should turn ‘other text’ off, since it cannot be put into a MIDI file. If there are no lyrics, it is best to turn off
lyric recognition, or some text may be misinterpreted as lyrics. The different kinds of text may be treated
differently by a notation editor. (Also see section 2.9 under “Text and chords”.)

You can also choose a language for the lyrics using the drop down list. This will tell the recognition engine
to use the frequency of trigrams (ie how often three letter sequences like “abc”, “ing”, “ijk” occur) for the
given language, in order to resolve ambiguities. There is considerable similarity between languages at this
level, so don’t worry if the language you want is not available (choose one that seems similar) or if you have

lyrics in two languages (choose either). And don’t feel that you must set this ‘correctly’ for every scan.

When you set the above options, SharpEye automatically chooses an appropriate set of characters that it
will attempt to recognise. Occasionally, you may wish to override this using the check boxes in the lower



section of the dialog. Note that the more you characters you include, the more possibilities there are for
errors as well as for recognition - so don’t turn lots of characters on just because ‘they might be there’.

You can choose where SharpEye looks for lyrics and (guitar) chords. Here, auto (the default) means that
SharpEye will make the decision, which means that lyrics will be searched for below staves, while chords
will be searched for above and below, and assigned to the nearest stave. If you choose above staves or below
staves, this will force SharpEye to only look in the specified place. (For lyrics, there is currently (v2.67) no
difference between auto and below staves.)

Finally, the option Assign lyrics to up-stem voice tells SharpEye to assign lyrics to notes with up stems when
both up and down stem notes line up with a lyric syllable. With this option off, SharpEye will assign to
down stem notes in this situation. This option may be useful where there are two voices in a stave and you
want the lyrics assigned to a particular voice. It may affect how the lyrics can be edited in a notation editor.

2.5 Music Editor

Most of the time you are using SharpEye, you will be checking and correcting the output in the music
notation editor. The next chapter is devoted to this.

2.6 Hearing the music

SharpEye can play the music as MIDI. This option is only intended as an aid to spotting errors. You should
save as MIDI and use a MIDI sequencer to change instruments, etc.

You will find three commands on the File menu (Play, Stop playing, Play current measure). There are three
corresponding buttons on the tool bar. The Play option will play from the current measure if there is one,
otherwise from the start of the piece. The current measure is the measure in which there is one or more
selected symbols (notes, rests, clefs, key and time signatures). If there is no such symbol selected, or if there
is more than one measure selected, the current measure is not defined, and Play current measure will not be
available.

The MIDI options will affect the tempo and volume, just as when you save as a MIDI file, but repeats are
always ignored.

2.7 Saving Music Files

You can save the music as a MIDI file, a NIFF file, a MusicXML file, or in SharpEye’s own format (.mro).
If you save the music in SharpEye format, you can load it back later and continue editing. If you save it
as a MIDI file, you can play the file or edit it in a MIDI editor/sequencer. You can also import MIDI files
into most notation programs, but a lot of layout information is lost when you do this. NIFF and MusicXML
contain layout information, but you will need a program that imports such a file to make use of it. SharpEye
does not import MIDI, NIFF, or MusicXML files. You can find the usual save options under the File menu.
The Save music and Save music as will save in SharpEye’s own format, with similar options in the MIDI,
NIFF and MusicXML sub menus. There are also four save buttons. The one with the M is for SharpEye
format, the others are for MIDI, NIFF, and MusicXML.

There is also an option on the NIFF and MIDI sub menus to save a temporary file and then immediately
open it (as if you had double-clicked on it). This provides a simple way of transferring a NIFF or MIDI file
to another program. It is not guaranteed to work with any program, and will of course depend on how you
have the file associations set up for .mid and .nif files.

By default SharpEye will only regard files that are saved in its own format as ‘safe’, so when you save as
another format, the music will remain marked as edited. You can change this by going to Options - Warnings
options and unchecking Warn if not saved in SharpEye format.



2.8 Saving as MIDI

There are a few options for MIDI output available from the Options menu:

e You can set the tempo for the piece. The tempo is in quarter notes (crotchets) per minute, regardless
of the time signature.

e You can set the MIDI velocity (ie volume) for all the notes in piece. This is in the range 0-127, and
the default is 64. For example, if you are using Cakewalk to work on the MIDI files, it is convenient
to set this value to 100, since Cakewalk gives any new notes you insert a velocity of 100. Note that if
you set the velocity near zero, you will get a very quiet and possibly inaudible MIDI file which can be
confusing!

e You can decide whether repeat signs are taken account of or ignored when generating the MIDI file.

e You can choose whether to include any lyrics that SharpEye has found. Note that it is not possible
to put more than one line of lyrics into a MIDI file - SharpEye puts in the top line of lyrics if there is
more than one. Also note that some programs that import MIDI files ignore any lyrics. When a stave
is split (see below) you can decide whether the up-stem part gets the lower channel number.

e You can make SharpEye put different voices on different channels, so that notes with up stems will get
a different channel number to those with down stems. This can be set per stave using the circles at
the start of the score. You can toggle between one circle (one channel output for that stave) or two by
clicking on them.

e You can join pairs of staves. This puts both staves on one MIDI channel. This also changes the way
that SharpEye analyses the rhythm, and is described in more detail in section 3.10.

The MIDI format has both and channels, and this sometimes causes confusion. SharpEye always uses one
track per stave, but allows channels to be assigned quite flexibly. To take a common example of an SATB
score for 4 voices, written on 2 staves as SA+TB, the tracks and channels will be assigned like:

S track 1, channel 1 track 1, channel 2 track 1, channel 1
A track 1, channel 1 track 1, channel 1 track 1, channel 2
T track 2, channel 2 track 2, channel 4 track 2, channel 3
B track 2, channel 2 track 2, channel 3 track 2, channel 4

where the first column is with no splits; the second column has both staves split and the Up stem parts on
low channels option off; and the last both staves split with this option on.

MIDI sequencers need to know the timing of notes, so grey notes are omitted when exporting MIDI files.

Short notes wrong

If notes have the wrong length when imported into a MIDI sequencer, check that the settings in the sequencer
are appropriate. Sequencers often expect input to be played in on a keyboard, and may be set up to force
notes into a particular rhythm. This may misinterpret short notes and rests in MIDI files.

2.9 Saving as NIFF

NIFF (Notation Interchange File Format) is a music notation format which can contain much more infor-
mation than MIDI which stores little more than the sound of the music. For example, information about
stem direction, beaming, expression marks such as staccato and accent, ties and slurs are all lost when
SharpEye makes a MIDI file. Even clefs and bar lines cannot be put into a MIDI file, though they may be
reconstructed by the program reading the MIDI file. NIFF was designed to overcome these limitations and
provide a publicly documented format for interchanging music notation information between programs.

NIFF is becoming increasingly popular, but it is a very flexible format and different people are using it in
different ways. SharpEye therefore gives you some control over the kind of NIFF it generates via the NIFF
options dialog.
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In order to make use of the NIFF facility you need a program that imports NIFF files. It is best to look at
the SharpEye web site www.visiv.co.uk for the latest information about this, since more and more programs
are supporting NIFF. If your favourite notation program does not import NIFF, and you would like to use
SharpEye with it, please ask the producers to add this feature.

Graphical and musical NIFF

The ‘Musical’ NIFF export writes a file which omits the grey notes. As long as you do not have the Relaxed,
allow overlong measures option set for rhythm analysis, the NIFF file will be rhythmically consistent, that is,
notes will not over spill measures.

The ‘Graphical’ NIFF export writes a file similar to that generated by Smart Score (another music OCR
program). Grey notes are included. In this case, there will be some rhythmic errors unless you ensure
everything is correct before exporting.

Both Musical and Graphical NIFF export include the positions of all the staves, notes and rests and some
other symbols. The Graphical export leaves more work for the importing program to do, and may not be
understood by some programs. On the other hand it includes the grey notes, so if the importing program
can cope with rhythmic inconsistencies, this may be an advantage.

Scan DPI

There is also an edit field where you can enter the scan resolution in DPI. It may seem strange to have
this under NIFF options, but it is only when saving as NIFF or MusicXML 1.1 that the scan resolution has
any effect on the way SharpEye behaves. If you set this correctly, the dimensions in the NIFF file will be
(approximately) the same as the original. If it is set incorrectly, the whole NIFF file will be scaled, but it
will still be a valid NIFF file.

Text and chords

When exporting as NIFF, you can choose whether lyrics and other text are in a sans serif font (Arial), or a
serif font (Times).

Finally, there is an option to export guitar chords (text like “Am”, “D§7”, etc) as plain text, or as NIFF
chord symbols. If the NIFF importer understands NIFF chord symbols, they will become chords in the
notation program (which can have fret diagrams, transpose properly, etc), but not all NIFF importers are
capable of this.

Parts and voices

NIFF has provision for both parts and voices, with voices being a subdivision of parts. The precise meaning
and function of parts and voices is not well defined so different programs may interpret them slightly differ-
ently. One thing does seem clear, which is that it should be possible to extract a single part from a NIFF
file (eg for an individual performer), and for this reason SharpEye gives you some control over how notes are
divided into parts. (Voices are assigned automatically within parts.)

Normally there is one part per stave. If you join two staves at the start of the score, they will become one
part in the NIFF file. You can also split a single stave into two parts, so that SharpEye will give notes with
up stems a different part to those with down stems. This can be set per stave using the circles at the start
of the score. You can toggle between one circle (one part for that stave) or two by clicking on them.

2.10 Saving as MusicXML

MusicXML is a format being developed by a company called Recordare. See www.recordare.com for
general information about the MusicXML format and software which supports it.

The facilities for saving as MusicXML are on the File menu. In general, programs that import MusicXML
need to know the timing of notes, not just where they are, so grey notes are omitted when exporting
MusicXML files.
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MusicXML 1.0 and 1.1

The MusicXML options dialog box (which is opened from the Options menu) allows you to choose to export
MusicXML 1.1, or the default 1.0. The main difference is that 1.1 includes more layout information. Mu-
sicXML 1.0 cannot represent detailed graphical information about the music. However it can be useful to
preserve the page and system breaks in the original scan, and these can be optionally included. If you choose
to export MusicXML 1.1, the extra layout information includes the page and system breaks, page size and
margins, vertical spacing of systems and staffs, staff heights and measure widths. You will of course need a
notation program that understands MusicXML 1.1 to take advantage of these features. Note that SharpEye
does some ‘tidying up’ when calculating these values. For example, in a multi-page score it estimates a single
page size and set of page margins, and it never uses more than two stave sizes (ie either normal size only, or
normal and cue size). throughout a score.

Scan DPI

There is also an edit field where you can enter the scan resolution in DPI. It may seem strange to have this
under MusicXML options, but it is only when saving as MusicXML 1.1 or NIFF that the scan resolution has
any effect on the way SharpEye behaves. If you set this correctly, the dimensions in the MusicXML 1.1 file
will be (approximately) the same as the original. If it is set incorrectly, the whole MusicXML 1.1 file will be
scaled, but it will still be a valid MusicXML 1.1 file.

Parts in MusicXML

This works in a similar way to NIFF. Normally there is one part per stave. If you join two staves at the
start of the score, they will become one part in the MusicXML file. You can also split a single stave into
two parts, so that SharpEye will give notes with up stems a different part to those with down stems, using
the circles at the start of the score. MusicXML handles parts somewhat differently to NIFF, so if you split
a stave, each part will have its own stave.

2.11 Multi page scores

Music scores are often more than one page. You can deal with these in several ways. One option is to
process pages individually as usual, and join them together in a MIDI or notation editor. Alternatively, you
can convert the pages individually into SharpEye’s own output format, and then join them in SharpEye (see
below). A third, more automatic option is described in the next section.

For example you might have scans of a three page score called pagel.tif, page2.tif, and page3.tif. You can load
these one by one into SharpEye and convert them, saving them as pagel.mro, page2.mro, and page3.mro.
Then load pagel.mro into SharpEye, then page2.mro, then page3.mro. Each time you load an output file
into the editor when there’s already a score there, you will be asked if you want to replace the existing score
or join the new one onto the end. Obviously in this case you should choose Append.

You can load the *.mro files by double-clicking on them, by dragging them into SharpEye’s main window,
or via the Open File dialog. You can do corrections before and after joining. SharpEye will automatically
load the correct image as you edit different pages, as long as the image files are still where they were when
first converted.

Appending a file to an existing score is a ‘large’ operation, so by default SharpEye warns you to save your
work before appending. If you find these warnings annoying, you can turn them off by going to Options -
Warnings options....

2.12 Batch processing

SharpEye has a ‘batch mode’, so that many images can be processed at once. These might be several pages
from the same score or separate pieces of music. The batch mode converts a set of image files into music
files in SharpEye’s own format. It can also join the output files together. In order to set up a batch, choose
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Batch process from the Image menu. This opens a dialogue where you can choose the images to be converted
and the folder where the output music files will be put.

The Add files... button opens the standard Open File dialog, where you can select one or more images (TIFF
or BMP files). You can add images from several folders, but note that they must all have different names.

If you want to remove some files from the batch, select them and use the Remove selection button.

You also need to choose an output folder where all the music files (*.mro files) will be put. The Browse...
button allows you to do this. If there are already music files in the output folder with the same name(s)
they will not be overwritten - instead there will be an error for this image. It is advisable to use an empty
folder for the output folder to avoid confusion.

If you check the Join files after conversion option, all the output music files will be joined together to form
a single file, in addition to the individual files. Obviously, this only makes sense if the images are scans of
pages from the same score. The files are joined in alphabetical order of file name, as they appear in the
batch window. The name of the combined file is “AllPages” by default, but you can edit this in the edit
box. Now you can click on Start batch to start the processing. A window will open to show you how things
are going. This shows a list of the files and their status. The image being processed will have “Converting”
next to it. Once it is finished it will become “Done” or “Error” if the conversion fails for some reason. If
there are any errors, a log file “SharpEye batch errors.txt” will be created in the output folder where you
can look for more details. This will overwrite any previous file with the same name.

While a batch is being processed various options are disabled. You can stop the batch by clicking on the
Stop batch button in the Batch progress window, or by closing this window.

2.13 Miscellaneous Options

This covers the setting and saving of various options in the options menu.

MIDI output options

See the section 2.8 for the meanings of these settings. These are saved when you exit the program so that
they will still be as you set them next session. The settings in the MIDI options box are used for newly
converted images. However, note that these values (except the Up-stem parts on lower numbered channels
option) are also saved in the corresponding SharpEye music file (.mro file), so if you load a SharpEye file,
this will replace the settings in the MIDI options box.

NIFF output options

See section 2.9 for the meanings of these settings. These are saved when you exit the program. They are
not stored in .mro files.

MusicXML output options

See section 2.10 for the meanings of these settings. These are saved when you exit the program. They are
not stored in .mro files.

Music and Text Recognition options

See section 2.4 for the meanings of these settings. These are saved when you exit the program.

Warnings options

There are three options here. See section 2.11 for the one about appending, section 2.7 for the one about
saving in SharpEye format, and under 2.2 for the one about reading an unsaved image. These are saved
when you exit the program.

Rhythm analysis options

See section 3.3 for the meanings of these settings. These are saved when you exit the program.
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Window Positions

You can arrange the image and music windows as you like, and then choose Options - Save window positions.
This will set the initial positions for the next time you start SharpEye.

Saving and loading options

Sometimes it may be useful to save all the current options in a file which you can load later. The Save
options... and Load options... menu items allow you to do this. The options are saved in a plain text file, but
it is not recommended that you edit these files in another program.

Directories for image and music files

SharpEye saves the directories (folders) you use for images, its own music files, MIDI, NIFF and MusicXML
files, and the batch directories when you exit the program.
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Chapter 3

The Music Editor

3.1 What it does and doesn’t do

The music editor in this version of SharpEye never formats the music. For this reason alone it is not suitable
as a general purpose music notation editor. It is designed only for correcting the output from the music
OCR process. On the other hand, it has several features that are designed to help with the corrections.

The way you edit music in SharpEye is more ‘graphical’ and less ‘musical’ than a normal notation editor. In
general, you should think in terms of drawing onto the score, in order to make it look like the original. For
example, adding a clef to most notation editors will change the position of following notes in order to keep
the pitches the same. This is inappropriate for correcting scanned music, so SharpEye keeps the position of
the notes the same instead. Another example: when you enter notes in most notation editors, you tell the
program when the note should occur, and which voice it belongs to, and the program decides exactly where
to put the note. SharpEye works the other way: you decide exactly where the note should go, and SharpEye
analyses the measure to decide the voice and start time for the note.

The music editor window is linked to the image window, so that when you click in the editor, the image
scrolls to the same place in the image. A red cross shows the point in the image which corresponds to the
cursor position. Do not rely on this cross for accurate positioning if staves are of different sizes, or not
exactly straight. It displays warning symbols at the end of each bar (measure) that has errors or ambiguities
in the rhythm. It also draws any note heads that it can’t understand in grey. This works a bit like a spell
checker, and directs your attention to likely errors.

It is intended to be easy to learn. Almost everything can be done with the mouse and the Delete key.
SharpEye does not try to ensure that what you do looks good. There are many ways of writing a piece of
music which will produce the same sound (and in most cases the same MIDI file). Some are sensible and
some aren’t - SharpEye doesn’t try to make you sensible! SharpEye is also fairly limited in its ability to
avoid clashes of symbols, and in complex or crowded music symbols may overlap one another.

3.2 Simple Editor

From the View menu, you can open a dialog box which provides some simple editing facilities. It is aimed
at visually impaired users, and at those who want to get the score into another program without using
SharpEye’s normal editing facilities. It enables you to set the initial key and clef for each stave, and
optionally copy these to other staves. If SharpEye misreads clef or key changes that occur later, you will not
be able to correct them using this dialog.

The dialog shows the information for one stave at a time, and the Previous and Next buttons allow you to
move from stave to stave. The score is not changed until you click on the Apply button. If you move from
one stave to another without clicking on Apply, any changes you made to the old stave are ignored.
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The clef and key signature can be set from a dropdown lists. Once you have set these correctly, you can
check the boxes to copy the clef or key to other staves. Copying to other staves in system means copying
vertically, while copying to later systems means copying horizontally to the same stave in other systems. If
you check both these boxes the clef or key will be copied to every stave in the score.

The radio buttons allow you to split a stave into two parts or join a stave to the next stave, giving the same
functionality as the circles and rectangles at the start of the score. See section 3.10 and the ones on saving
the music as MIDI, NIFF and MusicXML for more information.

3.3 Warnings about rhythm problems

SharpEye uses two methods to indicate problems with rhythm. At the end of each measure that contains a
problem, just below the barline, it displays a warning symbol (a blue triangle). In such a measure, it may
also display some of the notes in grey instead of black. This means SharpEye is not sure when they should
be sounded. SharpEye also displays ties, slurs and lyrics in grey if it doesn’t know which notes to attach
them to.

The status bar shows how many measures still have warnings.

If you see the warning sign, but no grey notes, it means there are not enough notes or rests to fill the measure.
This is probably because SharpEye has missed a note or has made a note too short, perhaps by missing an
augmentation dot. If there are warnings on lots of measures, it may be a time signature error. If SharpEye
misses, or misreads a time signature, or if the music is from the middle of a piece and so contains no time
signature, it will cause lots of warnings.

If there are grey notes, there are two main causes. The first is the opposite of the problem above: SharpEye
has ‘seen’ a note (or rest) that is isn’t really there, or made a note too long by missing flags or beams, or
there is a time signature error.

The second cause of grey notes is a bit more subtle. It may be that there are neither too few nor too many
notes, but it is still not clear when they should sound. This typically happens in keyboard music, where two
staves are used for one instrument. By default SharpEye looks at each stave individually when analysing
measures. But keyboard music often only makes sense by looking at both together. The best cure here is
to join the two staves at the beginning of the score. An alternative is to add rests to fill in the gaps in each
stave, but that’s usually a lot more work!

3.4 Controlling Rhythm Analysis

You can control how strict SharpEye is when it analyses the rhythm, using the Rhythm analysis options dialog
from the Options menu.

e Strict: SharpEye expects every voice in every measure to be complete (ie to exactly fill the measure).

e Normal: SharpEye expects every measure to contain at least one voice which is complete, and will
assign start times to notes from incomplete voices if they line up with those in a complete voice, but
leave other ones grey.

e Relaxed, no overlong measures: SharpEye will assign start times to all notes that it can without any
note ‘over spilling’ the measure, ie ending after the measure is supposed to end according to the time
signature.

e Relaxed, allow overlong measures: SharpEye will assign start times to all notes, even if they over spill
the measure.

In the case of music with one voice per stave, there is little difference between the first three options. Things
get more interesting when there is more than one voice. The Strict setting is appropriate if you have music
where two independent parts are written on one stave, using up stems for one part and down stems for the
other. This setting will give a lot of spurious warnings on some piano music, where voices are used much
more flexibly. Either Normal or Relaxed, no overlong measures would be better for this.
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It also depends on whether you want to make sure the music is as correct as possible before exporting (choose
a more strict setting), or whether you prefer to get the music into another program and do any corrections
there (choose a more relaxed setting). The Relaxed, allow overlong measures is likely to confuse importing
programs, but it may be useful in some cases.

You can also control the maximum number of voices that will be assigned per stave using the radio buttons
next to Maximum voices per stave. This can be useful in spotting errors. If you know that there should never
be more than two simultaneous voices, and you set this to two, you will get rhythm warnings whenever
SharpEye has used three or more voices in a measure.

3.5 Selections

You can select objects by clicking on them, and they will become red. Once they are selected you can modify
them or delete them.

Clicking on a barline or time signature will select all the ones vertically above and below in the same system
(ie all the ones that occur at the same time).

When you click on a notehead that is part of a chord, it will become red and the rest of the chord will
become dark red. This is to indicate that you can modify either the chord or the single note but pressing
the Delete key will just delete the note. You can select the whole chord by double-clicking.

You can select multiple notes, chords and rests by using Control-click, as long as they are all in the same
system. You can also hold down the Shift key, and drag out a box with the mouse to make a selection.

You can select a complete line of text by double-clicking on it. It can then be deleted but not otherwise
modified. When you have selected something, you can delete it with the Delete key. Also a toolpane with
dark red symbols will open at the top for modifying the selection.

3.6 Deleting objects

Symbols are deleted by selecting them and using the Delete key, the Backspace key, or Ctrl-X.

Note that some objects - augmentation dots, triplets, accidentals, and articulation marks such as staccato,
tenuto, accent and the pause sign (fermata) are regarded as properties of notes and not as symbols in their
own right. In order to ‘delete’ these, you should select the note or chord they belong to and modify it
appropriately.

If you select a lyric word, or other text, the delete key operates in the editable field in the toolpane, ie
deleting individual letters. If you select a whole lyric line (by double-clicking) you can delete it with the
delete key.

You cannot delete the rightmost barline in a system.

3.7 Modifying Symbols

The general method is to select the object(s) you want to change in the score, then click on the symbol in
the toolpane that you want to change it into.

Clefs and keys

These are straightforward, the only slight complication is when a key signature changes the key to C. The
natural sign in the key signature toolpane is for this. If you change an existing key signature using this, it
will show as the right number of natural signs to cancel the last key signature.

Also see section 3.12 for how to edit many clefs and key signatures at once.
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Time Signatures

If you can see the symbol you want, click on it as with clefs and keys. For less common time signatures,
enter the signature in the edit box (eg “12/16”) and then click on the p/q symbol next to it.

Lyrics and other text

You can edit lyrics a word (or syllable) at a time in the edit field. If you insert a space in the word, SharpEye
will split the word into two at this point. It attempts to attach the parts to nearby chords. If this fails, one
or both parts will become grey, and you will need to move them.

Other text can also be edited in a similar way, but is not divided into syllables, you just edit the line of text
as a whole. Note that in order to make a visual distinction between lyrics and other text, SharpEye displays
lyrics in a sans serif font (Arial) and other text in a serif font (Times), and that guitar chords appear in
green. Editing of text is quite limited. You cannot change the style (bold, italic) or size of the text or add
new lines of text.

Dynamics

These are straightforward: the symbols pppp ... ffff and various others as well as hairpins can be edited.

Rests

You can change the kind of rest and also set the number of augmentation dots. To remove any augmentation
dots, click on the empty circle. (This circle is used to mean ‘none’ or ‘nothing’ elsewhere too.)

To convert a rest into a multi-measure rest, first make sure the all other measures in the system have no
notes in them, then enter the required number of measures in the edit box at the right, and click on the
multi-measure rest next to it.

You can set or remove a pause sign (fermata). The fermata symbol toggles the symbol on or off.

You can set or remove a triplet or other tuplet on any rests and notes in one measure. See under modifying
notes for more details.

Notes and chords

Most modifications apply to a note or to the whole chord if the head is part of a chord. You can select
multiple chords and apply the same operation to all at once. A couple of operations only make sense if more
than one note or chord is selected.
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At the left of the toolpane there is a tool for swapping the stem direction of a note. This will swap all the
notes in a beamed group if you select one note in the group.

LT T Y

Next is a tool for swapping between flags and beams. If you select some notes which are not beamed together
and click here, SharpEye will attempt to join them. Note that SharpEye will join quarter notes (crotchets)
in this way. This may not make musical sense, but it is useful for correcting common recognition errors (eg
due to broken stems). If you select one or more notes that are all within a beamed group, this will separate
them into single notes with flags. The notes must all be in the same measure and stave.

You can set the number of augmentation dots as with rests.

You can change the duration by clicking on one of the note symbols.

Below the note symbols are various articulations and ornaments. These toggle the symbol on or off.
You can change the accidental for a single notehead, or remove it by clicking on the empty circle.

To the right of the accidentals is a tool for vertically aligning selected notes. They must all be in the
same measure, but not necessarily in the same stave. The horizontal positions of the selected notes will be
averaged.
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Next to the right is a tool for adding and removing ties. If a note or chord has a tie to its right this will
remove it. Otherwise SharpEye will try to add a tie from the note or chord. Note that slurs are drawn in
thin lines, and ties with thicker lines to help distinguish them. Also note that ties or slurs which are not
attached at both ends are shown in grey. Ties and slurs can also be edited by dragging - see the next section.

Below the tie symbol are two tools for swapping between between grace note heads and normal ones. The
right-hand one also adds a slash to make an acciaccatura (if the note is not beamed).

You can add triplets and other tuplets by selecting the notes and rests you wish to affect, and using the
“n-" symbol. The edit box below is used to choose the kind of tuplet. It is entered as two numbers with
a colon : between. You should read “N:M” as “N notes in the time of M”. Common values are “3:2” for
triplets, “2:3” for duplets, and “5:4” for quintuplets. To remove a tuplet, select any note in the tuplet and

use the “~O-" symbol.

3.8 Moving symbols

You can move some objects by dragging with left button.

Noteheads can be moved up and down, and placed either side of the stem. You can also use the up and
down arrow keys to move a selected head up or down one step at a time.

Rests can be moved freely, as long as they stay in the same measure and stave.

Clefs and key signatures can be moved horizontally, as long as they stay in the same measure and stave.
Lyric words can be moved horizontally within the same line.

Slurs can be moved within a system. If you drag near one end you will move that end; the other end stays
fixed. If you drag near the middle you will be able to move the slur as a whole.

Dynamics (ppp...fif and hairpins) can be moved within a system. They will be attached to the stave above
unless they are above the top stave of a system, or very close to (touching or almost touching) the stave
below. It doesn’t matter much which stave they’re attached to in SharpEye, but it may affect how other
programs interpret the NIFF and MusicXML files that SharpEye makes. If you drag near the end of a
hairpin you can change its length. Drag near the middle to move it as a whole.

3.9 Creating symbols

The right button

You always use the right button to insert things. If you have been selecting things, the first right click
will not insert anything, but will show the insertion toolpane, with a symbol similar to the last selection
highlighted. The insertion toolpane uses green symbols to distinguish it from the modification tool panes.

Choosing a symbol

There are so many possible variations of musical symbols that to show all of them would make things hard
to find, or complicated to choose. Instead the insertion toolpane shows the basic kinds of symbol available.
You should choose a symbol that is close to what you want and then modify it after inserting it.
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For example, in order to insert a 3/4 time signature, you would choose the only time signature available in
the toolpane (a 4/4) and insert that in the right place. Then left click it to select it and change it to a 3/4
in the time signature toolpane. Bar lines work in a similar way.
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The three shapes of clef can be chosen directly. If you need a tenor clef you need to insert an alto clef (C
clef) and then change it.

There are two key signature symbols, one for flats and one for sharps, which insert a single sharp or flat. For
keys with more than one sharp or flat, insert either of these then modify it. If you need a key change to the
key of C insert either of these then change it by clicking on the natural sign in the key signature toolpane.

You can choose all the basic durations of rests, and add augmentation dots later if need be. You can convert
any type of rest into a multi-measure rest.

Notes and chords are a little more complex. You can only insert notes with flags, not beams. You can set
the stem direction using the three symbols on the left (up stem, let SharpEye decide, down stem).

To make chords, you add note heads to notes that are already there. For this use the symbol (which shows
a single note and a two-note chord) just to the right of the notes and rests. Do not try to make chords by
lining up two notes - SharpEye will regard them as separate notes and they will not behave as expected.

To insert a lyric word, choose the “la-la” symbol. Note that it is only possible to edit text in an existing
line of lyrics but not to insert a new line. Sometimes SharpEye will miss a complete line (usually when the
syllables are few and far between) and you will have to enter the text in a notation editor. Likewise it is not
currently possible to add other text, only to correct what is there.

To insert a slur, choose one of the curves just below the “la-la” symbol.

To insert a dynamic (ppp...ffif and hairpins) choose the “f” symbol for ppp...fff and one of the symbols below
for hairpins. As when moving a dynamic, they will normally be attached to the stave above. (See that
section for more details.)

When you have chosen a symbol to insert, the pointer will change to indicate this, but remember to use the
right button - the left button will still select things.

3.10 Joining Staves

It is sometimes necessary to join two adjacent staves in a system, usually because they are both to be played
by one instrument (eg keyboard or harp). The pair of staves is known as a grand staff. Joining staves in this
way enables SharpEye to analyse the rhythm properly, and will put both staves on the same MIDI channel.
SharpEye can recognise the braces which are usually used to indicate a grand staff, but you may wish to
over-ride this.

The black rectangles at the start of the score are for joining staves. Initially these are usually horizontal,
indicating the staves are separated. If you click on one, it will become vertical, joining a pair of staves. You
can reverse the operation by clicking again.

It is not always necessary to join staves in keyboard music. Sometimes the right hand and left hand parts
make sense independently. Occasions when it is necessary include:

(1) Where a single melody line is written on two staves, wandering between both, and with no rests to fill
in the measures where no notes are sounding.

(2) When the main rhythm is given by the left hand part of a piece for keyboard, and notes are aligned with
this in the top stave without rests or other notes to indicate when they sound.

On the other hand, it can be useful to separate two staves in a grand staff in order to help spot rhythm errors.
If the two staves have independent left-hand and right-hand parts, which should make sense individually,
you may wish to separate them as this can reveal more errors.

If you’re wondering what the circles at the start of the score are for, see sections 2.8, 2.9, and 2.10.

Note for experts: It might seem better if SharpEye always looked at neighbouring staves in a system to
analyse the rhythm. However there are problems with this approach as well. While the rule that notes that
sound together should be vertically aligned is usually followed, it is not always the case in printed music, so
this assumption can lead to errors too. Also, if SharpEye makes an error in one stave, it might spread into
other staves if it relied too much on vertical alignment. Future versions may handle this differently.
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3.11 Muting parts

Sometimes it can be useful to mute a part when checking for errors. You can do this by using Control-click
on the circles at the start of the score. This will toggle the part on or off, and is indicated by an outline circle
for a muted part. These settings are not saved in SharpEye’s own format, nor do they affect the export in
any format.

3.12 Edit Music menu

This menu contains some options for making ‘large scale’ changes to the score in order to save time. Some
of the options relate to ‘the current measure’. This means the measure (bar) in which there is one or more
selected symbols (notes, rests, clefs, key and time signatures). If there is no such symbol selected, or if there
is more than one measure selected, the current measure is not defined, and the option will not be available.

Undo

The first option is Undo, which is a one step undo.

Editing clefs and key signatures

The next two, Copy clef to and Copy key sig to work in a very similar way. First you select a clef or key
signature in the score. Then you can copy this symbol to the start of other staves, where it will replace
existing symbols of the same type if they exist. All staves in this system means the clef or key signature will
be copied ‘vertically’ that is, up and down to other staves but not to other systems. This stave from here on
will copy ‘to the right” but will only affect one stave throughout the score. All staves from here on will copy
vertically and to the right.

Recalculate triplets

SharpEye can recognise triplets, duplets, quintuplets, and sextuplets (2,3,5,6) as long as they have a bracket
or a beam which indicates which notes belong to them. Since triplet signs are often omitted, it also analyses
the rhythm and in most simple cases can determine which notes should be triplets. It does this calculation
when a new image is converted, but it can also be useful to let SharpEye have another go at finding triplets
once you have corrected some errors - especially if you have corrected or added a time signature. On the
other hand, if you have already edited some triplets, this might overwrite what you have done. You can
either let SharpEye recalculate triplets for the whole score, or from the current measure (bar) onwards, so
that it will not affect earlier measures.

Delete system

You can either delete a single system, or all systems from the current one (the one containing the current
measure) onwards.

Delete stave

In order to use this you must select a symbol in the first system of the score, in the stave you want to delete.
The stave is removed from the entire score, following the green arrows.

Split two-note chords

This option is for dealing with a particular situation where two parts (often two vocal parts in SATB music)
are written using up and down stems in some places, and as two note chords in others. This can confuse
the rhythm analysis, and also cause difficulties when the music is exported to another program. This is
especially important if you wish to extract the parts - the notation editor may not allow you to separate two
notes that belong to one chord. This tool allows you to convert such chords into two separate ones. It can
be applied to the notes that are selected, or to all notes in the current stave, or to all notes in the current
stave and the same stave in all later systems.
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Go to next rhythm warning

This will scroll the music editor so that the next measure with a rhythm warning will appear near the top
left of the window. There is also a toolbar button for this.

3.13 Irregular Systems

If SharpEye finds systems with different numbers of staves in the page (or when appending, in the score)
it will add extra empty staves at the bottom to make the score ‘rectangular’. These ‘invented’ staves are
shown in grey, and you cannot add notes to them.

In order to deal with scores like this, you can use the green arrows that are shown between systems. By
default they join each stave to the corresponding one in the next system, ie, they are ‘parallel’. This may
be correct, but often it isn’t. If this is wrong, you can drag the arrow heads up or down to join the correct
pairs of staves.

For example, it may be that all instruments are shown on the first system of a score, but on later systems,
instruments are dropped if they are not playing at that point. SharpEye will add empty staves at the bottom,
but unless it happens to be the bottom instrument that was dropped, this will mean that some instruments
are mismatched. However, if you change the linking arrows you can correct this, by linking the missing
instruments to the empty staves.

Here is another example. A piece for piano and voice has an introduction with two staves for piano only,
then the voice comes in on a third stave above the piano. At the point where the voice comes in, you need
to use the green arrows to join the invented stave to the voice like this:

- f)
—RH — ﬁ Voice —
e

o —

When you export the music as MIDI, NIFF, or MusicXML, SharpEye will respect the way the staves are
linked. It also attempts to put the staves in the correct overall order (for example in the case above the
voice should be above the piano throughout). To do this it looks for the first system with no invented staves
and uses the order of the staves in this system.

Not every score layout can be dealt with in this way, especially when an instrument or group of instruments
uses a variable number of staves throughout the piece. In such a case you may have to deal with the score
in sections and join them together with a music notation or MIDI editor.

3.14 Editing guidelines

If you're not sure how to go about checking and correcting a score, here are some suggestions.
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e Check the time signature(s) first. There’s usually just one at the start of the music, but some music has
changes in the middle. If there are warnings on most of the measures, the time signature is probably
wrong.

e Next check the clefs and key signatures. These usually occur at the left of each system, sometimes also
in the middle. If you export and play the MIDI file, and it mostly sounds OK, but it sounds horrible
for some section(s), its likely to be this kind of error.

e Look at all the measures marked with warnings.

e Remember that the warnings are like those from a spell checker and don’t catch all errors. Proof-reading
music to ensure there are no errors at all is difficult. Use your ears as well as your eyes.

e Editing of ties, slurs and lyrics is usually best left to last. Remember that they will be shown in grey
until SharpEye can attach them to notes.

If you have a MIDI sequencer or notation editor it is up to you how much editing you do in SharpEye and
how much you leave to do later. It is almost essential to ensure the time signatures, clefs, key signatures and
bar lines are correct before exporting, but detailed note editing can be done either way. In general, MIDI
sequencers and notation editors need to know the timing of notes, not just where they are, so grey notes are
omitted when exporting MIDI files and MusicXML files. For NIFF files you can choose whether to include
them (see Saving as NIFF).

3.15 Keyboard shortcuts

The Home and End keys will scroll the music editor to the previous or next system. If a notehead is selected,
the up and down arrow keys can be used to move it up and down one step at a time. There are also some
keyboard shortcuts to speed up the process of correcting errors which use the function keys. Not everything
can be done in this way, only the more common operations.

F1 starts the SharpEye help.

The other function keys only operate when inserting, and when modifying notes and rests. The keys F5
through F10 are assigned note durations as follows.

F5 F6 F7 F8 F9 F10
1/32 1/16 1/8 1/4 1/2 1

In insert mode, these select notes of these durations. In modify mode, they changed the selected rest or
notes to these durations.

When in insert mode, F2, F3, and F4 can be used to set the stem direction of the note to be inserted, in the
same order as the toolpane: F2=up, F3=auto, FA=down. F11 selects the “add head to chord” option. When
modifying notes, F2 swaps stem direction, F3 changes flags to beams or vice-versa, F4 cycles through zero,
one or two augmentation dots, and F11 cycles through the common accidentals: none, sharp, flat, natural.
When modifying rests, F4 cycles through zero, one or two augmentation dots. The available shortcuts are
summarised in the diagram below. The first line relates to the create toolpane, the others to modifying notes
and rests.

F1' F2 F3 F4 F5 F6 FT7 F8 F9 F10 F11 F12
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Chapter 4

Problems and Tips

4.1 Problems and Tips - Introduction

There is a lot of variety in musical scores: both the music itself and the styles and conventions used in the
layout. There is much variation in the quality of printing. There are also a lot of scanners available, often
with many options, which can be confusing. All this means you may have some difficulty getting SharpEye
to work well. This section tries to deal with the most common problems you’re likely to encounter, and
where possible, gives advice about dealing with them.

If you have a problem that is not covered here or think you have found a bug in SharpEye, there is information
on the SharpEye website and on reporting bugs in sections 5.1 and 5.2.

4.2 Limitations on notation recognised

This describes some limitations on the kind of music you can expect SharpEye to read.

It only recognises standard 5-line staves.

It does not deal properly with scores where the same instrument or instrument group uses different
numbers of staves in different systems.

e Chords and groups of beamed notes which span more than one stave are read, but converted into
one-stave objects.

There are some limits on size - maximum 50 staves per system, maximum image size 15000 width by
30000 height - which are not likely to cause practical problems. Only 15 channels are exported as
MIDI. (Channel 10 is avoided since it is usually used for percussion.)

4.3 Image quality
Please see the corresponding section in the on-screen Help, since it is important to compare what you see

on screen in the manual with what you see on screen in SharpEye’s image window.

4.4 Tips and techniques
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Adding notes to the right stave

Sometimes, notes on ledger lines may be much nearer a neighbouring stave than the one they should belong
to, which can cause a problem when inserting such notes.

When deciding which stave to insert a note into, SharpEye looks at symbols already belonging to each stave
as well as the position of the staves themselves. So if there are already notes on ledger lines nearby it will
usually add further notes to the correct stave. But if not, add the note near the correct stave, then drag it
up or down to the right position.

Selecting overlapping note heads

When two note heads coincide (as when two voices sound together) you can select one head by clicking
towards its stem. Eg, click just above the centre of the head to select the one with the up stem.

Partial measures

At the start of a score, and next to bar lines which are double lines, or repeat signs, there is a ‘partial
measure’ which may or may not be a complete measure. In such cases SharpEye tries to guess the length by
looking at the notes. This means the warnings are not as reliable as usual, and you should check these areas
carefully. If there is more than one stave, and the partial measures in different staves do not have the same
length, there will be warnings on all the measures. The warnings should disappear when everything is right.

4.5 Grey notes won’t go

There can be several causes for this. Here are some things to check:

Vertical alignment

Sometimes notes which should sound together are not vertically aligned. SharpEye can correctly analyse
some measures where this happens, but not all. You may have to move some notes to make things clear. If
the heads overlap significantly, or the stems are very close, they will be regarded as sounding together. More
rarely the opposite problem happens, and notes which should sound separately overlap enough to confuse
SharpEye.

Chords entered as two notes

It is possible, for example, to insert two or more 1/4 notes (crotchets) so that together they look like a chord.
However SharpEye will still regard them as separate notes which may confuse the rhythm analysis.

Missed notes in beamed groups

If SharpEye misses a note in the middle of a group of notes that are beamed together, it is not enough to
just add a note of the right duration. You must also join it to the group.

Rests in the wrong voice or stave

This is normally only a problem with multiple voices per stave. SharpEye expects rests in a voice to be
horizontally aligned with the nearby notes in that voice. You may have to move a rest up or down to ensure
this is the case. It is also possible for a rest to be put into the wrong stave if it is nearer the wrong one than
the right one. In this case you will have to delete the rest and insert a new one in the right stave.

Hidden overlaps

Occasionally, a symbol may be hidden by another symbol. When note heads are very close, a dot on a note
may be hidden by another notehead. Or a rest (eg whole or half note rest) may be hidden by something. If
you can’t guess what the problem is, you may have to delete symbols until you can see what is going on.
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Incomplete voices

When there are two voices in one stave, and one of the voices is incomplete (ie it doesn’t contain enough
notes or rests to fill the measure) some of the notes may be grey. See section 3.3 for more information about
this.

4.6 Images from unusual sources

Bitmap files

(‘Bitmap files’ means images made of pixels such as the formats BMP, TIFF, GIF, PNG, JPEG). Sometimes
you may want to convert an image that was not scanned from printed music. It may have been generated by
another program, or found on the Internet, or scanned as a grey scale or colour image and then converted
by some image processing program. These images often look OK to a person but convert badly or not at all
with SharpEye.

Often the scale of such images is too small. A typical scan at 300dpi will have the staff lines about 20 pixels
apart, and SharpEye can cope with a range of about 10 to 40 pixels. If the spacing is less than 10, SharpEye
will probably give up with a “Can’t find any staves in image. Music-OCR abandoned” message. Even if you
scale the image, it is likely the shapes will be too “chunky” and the recognition poor.

If the image is grey scale or coloured, it may look good to the human eye, but converting to the black and
white image that SharpEye needs can cause a lot of damage. Just as scanners often have a ‘dithering’ option,
image conversion programs have a similar option, which makes matters worse, so make sure any such option
is turned off.

Finally, don’t judge SharpEye’s performance on such images - unless these are the main kind of images you
want to process.

PDF files

SharpEye does not import PDF files directly. However, there are a number of utilities available which can
convert PDF files to BMP or TIFF files. PDF files generally work much better than bitmap files, though
since more or less anything can be put into a PDF file there is no guarantee. Be careful to set the resolution
of the bitmap appropriately. Usually 300dpi (as for scanning) is about right. If you have difficulty, it
may be helpful to read through the section on scanning, since many of the same considerations (resolution,
brightness, dithering) apply.

4.7 Black rectangles in display

A few people with ATI graphics cards have reported that the music display shows black rectangles instead of
musical symbols. This appears to be due to a bug in the device driver. It can be cured by going to Settings,
Control Panel, System, Performance, Graphics (in Windows 95,98 ME), or Control Panel, Display, Settings,
Advanced, Troubleshoot (in Windows XP), and reducing the hardware acceleration. A more satisfactory
solution is to obtain an updated driver for your graphics card which fixes the bug (if one is available).
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Chapter 5

Other information

5.1 Web site

The website www.visiv.co.uk contains the latest version of SharpEye, workarounds for problems when using
SharpEye, the latest information about registering, and so on. This should be the first place you look if you
can’t find what you want here.

5.2 Reporting Bugs

If you bought SharpEye from a distributor who provides support such as Tempo Productions (USA) Recor-
dare (USA, producers of Dolet), Et Cetera (UK), Dancing Dots (USA, producers of GOODFEEL), Optek
Systems (Australia, producers of Toccata), Lugert Verlag (German version), or Keynote (RISC OS version),
please report bugs to them. There are full and up-to-date details of SharpEye distributors on the links page
at www.visiv.co.uk.

If you bought directly from Visiv, or on-line via BMT Micro, you should contact Visiv for support, and to
report bugs. If you find a bug when using SharpEye, please visit the website www.visiv.co.uk if possible,
especially if you are not using the latest version. There may be a version of SharpEye with the problem
fixed.

If that doesn’t help, please send a description of the problem to us. You can use the form below as a starting
point. If you have a particular image or one of its own format music files that causes SharpEye to crash or
otherwise misbehave, please don’t delete it! We know it is pain for you, but that file may be valuable to us,
and we may well ask you to send it.

Please try to be as precise as you can about how to make the problem occur. If we can reproduce the
problem on our machine we can almost certainly fix it (assuming it is our fault). If we can’t reproduce it we
almost certainly can’t fix it.

SharpEye version:

Windows version:

Memory:

Other system details that seem relevant:
Problem happens always/sometimes/once
Description:

Email address: support@visiv.co.uk

27



5.3 Acknowledgements

We are happy to acknowledge the use of the TIFF library from Sam Leffler and Silicon Graphics. We would
like to thank Richard Hallas for advice on musical notation and Philip Hazel and Oliver Linton for helpful

comments.

28



Index

.mro file, 12 Graphical NIFF, 10
.mro files, 9 grey notes, 16, 25
grey scale, 6
accelerator keys, 23 guidelines (editing), 22
accidentals, 18 guitar chords, 8
Acquire..., 6
added staves, 22 halftone, 7
appending scores, 12 hearing the music, 9
articulations, 18
augmentation dots, 18 image - loading, 7
image editing, 7
bar lines, 19 image input window, 5
batch processing, 12 image zones, 8
beams, 18 inserting symbols, 19
bi-level, 6 inserting symbols (brief guide), 4
bitmap file, 7 installation, 3
bitmap files, 26 installsharpeye2.exe, 3
black rectangles, 20 invented staves, 22
blue triangles, 16 invert image, 7
BMP file, 6, 7 irregular systems, 22
brightness (scanning), 7
bugs, 27 joining scores, 12
joining staves, 20
chords, 20, 25 joining staves (brief guide), 4
clefs, 17, 20, 21
colours (scanning), 6 key signatures, 17, 20, 21
convert the image, 8 keyboard shortcuts, 23
creating symbols, 19
cue notes, 8 language, 8
line art, 6
deleting staves, 21 lyrics, 8, 18, 20

deleting symbols, 17

deleting systems, 21 main window, 5

directories, 14 memory, 3 .
dithered, 7 MIDI - saving, 9
dpi, 7 MIDI channel, 20

MIDI channels, 9
MIDI options, 9

MIDI tracks, 9
modifying symbols, 17

dragging symbols, 19
duration, 18
dynamics, 18, 20

Edit Music menu, 21 monochrome, 6

editing guidelines, 22 moving symbols, 19

editing music, 15 multi page scores, 12
multi-measure rest, 18

fermata, 18 music output window, 5

flags, 18 music recognition options, 8

folders, 14 musical directions, 8
Musical NIFF, 10

grace notes, 8, 19 MusicXML - parts, 12

29



MusicXML 1.0 and 1.1, 11
muting parts, 21

NIFF - chords, 11
NIFF - parts, 11
NIFF - text, 11
NIFF - voices, 11
note duration, 18
notes, 20

old style symbols, 8

one bit per pixel (1bpp), 6
options, 13

ornaments, 18

other text, 8

own format, 9

partial measures, 25
parts, 11, 12

pause sign, 18

PDF files, 26
photo, 7

play music, 9
problems, 24, 27

RAM, 3

reading the image, 8

recognition options, 8

resolution (scanning), 7

rests, 18, 20

rhythm analysis, 16

rhythm warning, 22

rhythm warnings (brief guide), 4
rotate image, 7

saving as MIDI, 9

saving as MusicXML, 11
saving as NIFF, 10

saving music files, 9

scan dpi, 11, 12

scanning, 6

scanning (brief guide), 3
scanning - general advice, 6
Select Twain source.., 6
selections (music editor), 17
shortcuts, 23

simple editor, 15

slurs, 20

small note heads, 8

sound, 9

stem direction, 18
syllables, 20

symmetric note head, 8
system requirements, 3

text, 18
text recognition options, 8
thin beams, 8

30

ties, 19

TIFF file, 6, 7
time signature, 19
time signatures, 18
tips, 24

triplet, 18

triplets, 19, 21
tuplet, 18

tuplets, 19
TWAIN, 6
TWAIN (brief guide), 3
two-note chords, 21

undo, 21
uninstall, 3
upgrading, 4

vertical alignment, 18
visually impaired users, 15
voices, 11

warnings, 13

warnings about rhythm problems, 16
web site, 27

window positions, 5, 13

zones, 8
zoom, 7



